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Description 
If you took Part 1 of this class (today or a previous year at AU) and are ready to learn even 
more, this class takes the next step as we look at the GIS capability in Civil 3D and how it can 
benefit Civil Engineers and Surveyors. GIS data can be created directly in Civil 3D or imported 
from other programs. Now that you have access to that data the real fun begins. This class will 
explore ways to analyze, display and leverage this information to answer questions and 
automate common tasks. The request to provide design data to GIS departments is becoming 
more common every day. This class will explore the details of why just sending them a drawing 
is often not an adequate way to satisfy that request. You will learn ways to export Civil 3D 
objects to GIS formats that can be used easily and consistently by your GIS department. 
 
 
 
Speaker(s) 
Rick Ellis is the President of CADapult Software Solutions, Inc., where he provides training and 
consulting services to clients around the country, helping them get the most out of their design 
software investment. Rick specializes in AutoCAD® Civil 3D®, AutoCAD® Map 3D, Autodesk® 
InfraWorks™, AutoCAD® Raster Design, and AutoCAD®. He is a member of the Autodesk 
Developer Network, and author of several critically acclaimed books on AutoCAD Civil 3D, and 
AutoCAD Map 3D; including the Practical Guide series. Rick continues to use AutoCAD Civil 3D 
on projects in a production environment, in addition to teaching classes to organizations both 
large and small around the country. This practical background and approach has made him a 
sought-after instructor by organizations around the world. 
 
rick@cadapult-software.com 
@theRickEllis 
 

Learning Objectives 
• Analyze Different types of GIS Data in Civil 3D 
• Create Thematic Maps to Display Complex Data in ways that are Easy to Understand 
• Export AutoCAD Geometry to Different GIS Formats 
• Export Civil 3D Objects to Different GIS Formats 
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Introduction to GIS in Civil 3D 
In addition to all of the tools built into Civil 3D for the civil engineering workflow, the software 
also includes many powerful tools for creating, editing, importing, displaying and utilizing a wide 
range of GIS and mapping data.  For instance, aerial and satellite imagery can be displayed, 
geometric data that includes corresponding tabular data can be attached to existing AutoCAD 
objects, such as lines representing pipes and polygons representing tax lots.  Geometry with 
corresponding tabular data can also be attached to, or displayed in Civil 3D drawing files, from a 
variety of GIS sources, such as ESRI Shapefiles and Autodesk SDF.  
 
Many of these additional tools can be used alone, or in various combinations, and are not 
necessarily limited to GIS and mapping projects, or even civil design projects.  Unlike most Civil 
3D workflow processes, these tasks are typically not linear.  For instance, for any given project 
you may use different combinations of these tools or processes, in different sequences. 
 
AutoCAD Civil 3D is built on top of AutoCAD Map 3D, which is built on top of standard 
AutoCAD.  Using the many tools found in Civil 3D, you can work with three types of objects: 
standard AutoCAD objects, (such as lines, arcs, circles, polylines and blocks); Map 3D objects, 
(such as Object Data, Topologies and connected Features); and Civil 3D objects, (such as 
alignments, profiles, parcels, surfaces, and pipe networks); and. These objects that are unique 
to the Map 3D tools in Civil 3D will be explained in the Lessons and exercises to follow. 

 
I would encourage you to think of this as a toolbox that contains many related, yet separate 
tools. Each tool has its own function and purpose. As you learn and become proficient with 
these tools you become a skilled craftsman knowing what tool is best suited for each task you 
encounter during your project. I would encourage you not to limit yourself to simply the 
examples demonstrated here. Focus instead on the individual tools. There are many different 
applications for them and once you understand how to use these tools, not just blindly follow a 
series of predefined steps, then you will truly unlock the power and productivity that is available 
to you. 
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1 Analyze Different types of GIS Data in Civil 3D 

Once GIS data has been imported or created in Civil 3D there are a number of ways you 
can analyze and use that data.  The commands you use depends on the format that the 
data is in.  In this lesson you will first work with AutoCAD Objects that have Object Data 
attached.  Then you will work with different commands to analyze attached GIS Features.   

Analyzing AutoCAD Objects with Object Data 
 

1.1 View Object Data on Existing Objects 

 
  For this exercise you should be in the Planning and Analysis workspace. 

1. Open Sewer.dwg from the class dataset folder. 

2. Pick one of the sewer lines, then right-click and select ⇒ Properties. 

3. In the Properties palette, scroll to the 
bottom and notice the object data that is 
attached to that line. 

4. You can view and edit any of the object 
data here as needed. 

 

5. Close the Sewer drawing. 
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1.2 Query by Pipe Size from Object Data 

  For this exercise you should be in the Planning and Analysis workspace. 

In this exercise you will use a query to find all sewer pipes 10 inches or larger. 

1. Start a new drawing using the ACAD.dwt template. 

2. If the Task Pane is not visible, at the command line enter MAPWSPACE. 

3. At the command line, enter ON to display the Task Pane, which includes the Map Explorer. 

4. Select the Map Explorer tab of the Task Pane. 

5. Drag and drop the drawing Sewer.dwg from the class dataset folder in Windows Explorer 
into the Map Explorer tab of the Task Pane. 

This attaches the Sewer drawing to the current drawing and makes the data in it available for Queries. 

6. In the Map Explorer, right-click on Current 
Query and select ⇒ Define… 

 

The Define Query of Attached Drawing(s) dialog box opens. Here, you set up the 
parameters of your query. 
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7. In the Query Type section, click <<DATA>>. 

This opens the Data Condition dialog box. 

8. Choose the Object Data option. 

9. From the Tables: drop-down list, select 
Sewer_Pipe_Data. 

10. From the Object Data Fields: list, select Size. 

11. From the Operator drop-down list, select Greater than 
or equal to (>=). 

12. In the Expression section, for Value: enter 10. 

13. Click <<OK>>. 

 

This returns you to the Define Query of Attached Drawing(s) dialog box. 

14. Confirm the Preview mode is chosen, and click <<Execute Query>>. 

15. Zoom extents to see the pipes. 

Only pipes 10 inches and larger are displayed in the preview. 
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16. Type R to REDRAW and clear the preview of the query. 

Next you will refine the Query to find only the pipes that are greater than 10 inches and are concrete. 

17. In the Map Explorer, right-click on Current 
Query and select ⇒ Define… 

 

 

This returns you to the Define Query of 
Attached Drawings dialog box. Notice the 
Data: Sewer_Pipe_Data.Size >=10 
portion of the compound query is now 
defined. 

Next, you will define the Material portion 
of the query. 

18. Confirm the And option is 
chosen in the Query Type 
section. 

19. Click <<Data>>. 
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20. Choose the Object Data option. 

21. From the Tables: drop-down list, select 
Sewer_Pipe_Data. 

22. From the Object Data Fields: list, select 
Materail. 

23. From the Operator drop-down list, select  
Equal  (=). 

24. In the Expression section, for Value: enter CON. 

25. Click <<OK>>. 

 

This returns you to the Define Query of Attached Drawing(s) dialog box. 

Notice the Current Query defined at the 
top of the dialog box filtering on both the 
Size and Material data. 

26. In the Query Mode section, 
choose Draw. 

This will copy all the objects that meet 
the query criteria into the current 
drawing. 

27. Click <<Execute Query>>. 

The sewer lines that are 10 inches or 
larger with a material of concrete are 
drawn into the current drawing. 

 

 

28. Select one of the sewer lines, right-click and choose ⇒ Properties. 

Notice that the Pipe Size and Material match our query. 

29. Right-click on the attached drawing in the Map Explorer and select Detach. 

Detaching the drawing breaks the link from the queried objects to their source drawing.  If this link is 
maintained you can edit the objects and save them back. 
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Analyzing GIS Features 
There are a different set of tools to work with attached GIS feature data.  These are not 
AutoCAD Objects and this lesson will explore ways to view and analyze their data. 

The Expression Builder 
This lesson introduces you to the basics of using the Expression Builder. This feature is a 
dialog that is used throughout Civil 3D, and the same interface is used in other Autodesk 
products. The advantage of this commonality is that once you understand and can 
effectively use the Expression Builder, your knowledge transfers to the other products. 

You launch the Expression Builder from various commands that are contextually correct 
for that particular purpose, such as Create Query, Add to Map with Query, or Search to 
Select. The actual functions within the Expression Builder remain the same regardless of 
where you launched it. 

 

 
 
When you first launch the Expression Builder, three options are presented to assist you in 
getting started: 

• Start a simple filter. 
• Start a filter with multiple conditions. 
• Filter features by locating on the map. 
• Once you become familiar with using the Expression Builder, you can dismiss the Getting Started 

guides. 
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Expression Builder Process 
The following is an example of how an expression is created in the Expression Builder. 
This example selects parcels on Dwayne CT which have an improved value below 
$100,000. Following is the final expression that is built in this example. 

 
 

1. The first step in creating an expression is to select the data upon which the expression is 
built. In this example, since the expression is based on parcel data, Search to Select is 
launched from the Parcels Data Table. 
 

 
 
Notice the expression that is built after each entry. 
 

2. Select the STNAME value. 

 
3. Select the Equals operator. 

 
4. Select the DWAYNE CT value. 

 
5. Select the And Boolean operator. 

 
6. Select the IMP_VALUE value. 

 



 
 

 
Page 10 

7. Select the Less Than operator. 

 
8.  Enter 100000 value. 

 
 
The result of this expression is that all parcels on DWAYNE CT that have an improved 
value of less than $100,000 are selected in the drawing. 

 

 
 
 
 
Feature Query and Filter to Select Defined 
Queries and Filter to Select expressions are built the same way. The main difference 
between the two functions is that queries limit the features in the map and Data Table, 
and Filter to Select selects the features in the map. 

 
 

Exercises: Create a Query, and Filter to Select Expression 
In these exercises you begin in a map with streets, parcels and a flood zone polygon. 
You first create a Filter to Select expression to select all the private road segments in the 
city. You then create a query to identify all parcels that intersect with a flood zone. 

You do the following: 

• Create a filter 
• Create a query 
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1.3 Preforming a Filter to Select 

  For this exercise you should be in the Planning and Analysis workspace. 

1. Open Feature Filter.dwg from the class dataset folder. 

2. If the Task Pane is not visible, at the command line 
enter MAPWSPACE. 

3. At the command line, enter ON to display the Task 
Pane, which includes the Display Manager. 

4. On the Task Pane select the Display Manager tab. 

5. In the Display Manager, select the Streets feature 
layer, and then click the Table button. 

 

The Streets Data Table is displayed. 

6. In the Streets Data Table, 
click Search to Select. 

 

The Search to Select dialog box is displayed. 

7. In the Search to Select dialog box, click Property. 

8. From the drop-down list of properties, select OWNER. 

The OWNER property is added to the Expression Builder. 

9. Click the = button. 

The equal operator is added, and the value prompt appears. 

10. In the upper right portion of the Search to Select dialog box, click Get Values. 
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11. For Select Property to retrieve, confirm OWNER 
is displayed. 

12. Click the green arrow button . 

13. From the list of values, select PVT. 

14. Click Insert Value. 

 

The statement is added to the Expression Builder.  

15. Click <<OK>>. 

All privately owned street segments are selected in the drawing, and the table highlights 
the 27 corresponding records, filtered from the total. 
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1.4 Preforming a Feature Query 

  For this exercise you should be in the Planning and Analysis workspace. 

1. Open Feature Query.dwg from the class dataset folder. 

2. In the Task Pane Display Manager tab, select the Parcels feature layer. 

3. Select Ribbon: Vector Layer ⇒ View  ⇒ Query to Filter. 

 

4. In the Create Query dialog, click Locate on Map. 

5. From the drop-down list, select Polygon under Touching Any 
Part Of. 

 

6. At the command line, enter S to select an existing polygon. 

7. Press Enter. 

8. Select the blue polygon representing the flood zone. 

The condition is added to the Expression Builder. 

9. In the Create Query dialog box, click the AND button. 

10. Click the Property button, and select IMPVAL from the Numeric Values section near the 
bottom of the drop-down list. 

11. Click the > (greater than) symbol. 

The expression prompts for the value. 

12. Enter 0 (zero). 

13. At the lower-left portion of the Create Query dialog, click Validate. 
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The expression should validate, and look 
like the illustration. 

 

14. In the Create Query 
dialog box, click 
<<OK>>. 

Only those parcels that intersect 
the flood zone, and have an 
improved value greater than zero 
are displayed in the drawing editor. 

 

15. Open the Parcels feature layer data table and examine the tabular results of the query. 

Lesson Review 
In this lesson, you accurately selected and identified all the private roads in the city. This selection can 
then be used to modify these road segments for further analysis. You also identified all parcels that 
intersect with a flood zone. In addition to this intersection, you narrowed the query to identify only parcels 
that had an improved value greater than zero. This eliminated all city-owned properties during the query. 
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2 Create Thematic Maps to Display Complex Data  

 

About Scale Dependent Styles 
When working with drawings that are dense in geometry, you can make styles scale-
dependent to establish display behaviors based on the scale at which you view the 
drawing. When working with hardcopy maps, or plotted drawing sheets, this scenario is 
built into the creation of the drawing. When the drawing is produced, the creator must 
determine the theme of the intended map; what is important, and what is not when 
producing the drawing. Working with drawings in Civil 3D or any other mapping 
application, the challenge is to create a display that is meaningful when an overwhelming 
amount of data is available. 

 

In the following example, a drawing contains all the geometry for the storm and sewer 
infrastructure of a city. Obviously, this data is not usable and is distracting when it is 
displayed at this scale. 
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When scale dependent styles are applied to the same drawing, the data displays in a 
manner that enables you to see only the data that is required as you zoom in and out of 
the drawing. In this example, no infrastructure is displayed beyond a specific scale 
threshold. As you zoom into the drawing, at a determined scale the infrastructure 
appears. Zooming further, labels appear. 

 

 
Methods of Scale Ranges 
Applying scale dependent styles to feature layers is the same as applying normal styles. 
The only difference is that you establish multiple scale ranges for the feature layer, and 
assign styles to each range. As you zoom in and out of the drawing, the corresponding 
style is displayed for that feature layer depending on the scale range. 

There are two main approaches to applying scale ranges in a drawing. 

• No Display 
• Change Display Style 

 

You can use one or a combination of both methods for a feature layer. 

No Display 
This condition is common. In many cases, the detail of mapping features requires that 
they not be displayed at all beyond a certain scale. In this case, a single style can be 
applied to a single range beyond which they do not display. 

Change Display Style 
In some cases, map features are useful at smaller scales, but benefit from being 
displayed differently at larger scales. An example of this situation is a road network. 
When viewed at a small scale, thin road lines serve to assist map viewers to 
geographically orient themselves. When zoomed in and viewing the same road network 
at a larger scale, more detail such as road name labels and thicker line weights can be 
displayed. 
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Working with Ranges and Styles 
By default, all styles have a 0 to Infinity range. This range means that whatever style is 
applied, it will display regardless of scale. Ranges can be added to a feature layer with 
custom scale thresholds, and styles can be applied to each range. 

 

In the following example, there are two ranges. Since the 0 – 2000 range is selected, all 
styles in the point style section apply only to this range. Ranges can be added, and 
additional styles can be added to each range. The critical point to understand when 
working in the Style Editor is that whichever range is selected in the upper portion of the 
palette, it corresponds to the styles in the lower part of the palette. 

 
 
 
 
Once ranges are created in a drawing, they can be selected and zoomed to by selecting 
the zoom scale in the Map Status Bar portion of the Drawing Status Bar. As you zoom in 
the drawing, the scale shown on the Status Bar updates dynamically. This scale is a 
model space representation of how the map would plot at that particular scale. 
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Exercise: Apply Scale Ranges to a Drawing 
In this exercise, you begin in a drawing that has several feature layers including parcels, 
sewer lines, and sewer manholes. The sanitary sewer manholes already have scale 
ranges applied. You create ranges and styles to display the sewer lines above a scale 
threshold, and place labels. 

 

You do the following: 

• Examine the behavior of an existing style. 
• Create scale ranges for the sanitary sewer lines. 
• Assign a label to the sewer lines. 

 

2.1 Working with Scale Dependent Styles 

  For this exercise you should be in the Planning and Analysis workspace. 

1. Open the drawing Scale Dependent Styles.dwg from the class dataset folder. 

2. If the Task Pane is not visible, at the command line enter MAPWSPACE. 

3. At the command line, enter ON to display the Task Pane, which includes the Display 
Manager. 

In the first step, you examine the behavior of scale dependent styles already defined. 

The tools to change map scale views reside on the Map Status Bar. In the standard, out-
of-the-box installation of Civil 3D, this status bar is not displayed by default.  

4. If the Map Status Bar icons are not displayed, enter MAPSTATUSBAR on the Command 
Line, and select <Show>. 

The Drawing Status Bar now shows additional tools for some AutoCAD Map 3D 
functions, such as 2D / 3D Viewing, Vertical Exaggeration, Coordinate Systems and View 
Scale 

5. Using standard AutoCAD zoom methods, zoom in and out of the map observing the changes 
in how Features are displayed at different scales. 

6. Notice that the manholes appear at scales below 1:5000, and that the labels for these 
Features appear at scales below 1:2000. 

In the next series of steps, you create the same behavior for the sanitary sewer lines. 
You first create two scale ranges. 

7. Zoom to the drawing extents. 
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8. In the Display Manager, select the feature layer 
Sanitary Lines, and then click the Style 
button. 

This opens the Style Editor palette.  

 

 

9. In the Style Editor palette, in the Scale Ranges… section, set the From and To scales for the 
existing range to 0 - 2000. 

10. Click <<Add a Scale Range>>. 

11. Set the scales for the new (second) second range to 2000 – 5000. 

The sanitary sewer lines will now display in both ranges but not above 1:5000.  

12. Select the 0 – 2000 range.  

The arrow in the row's left-hand column indicates that it is selected. 
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In the next series of steps, you assign a label to display in the 0 – 2000 range style, verify 
the settings and examine the behavior of the new style. 

13. In the Line Style for 0 -2000 section of the Style Editor, click the cell under Feature Label. 

The Style Label dialog is displayed. 

14. In the Style Label dialog box, for Size 
Context, choose Map. 

15. For Units, select Feet. 

16. Click <<Add Label>>. 

17. For Size, enter 10. 

18. Set the text color to green. 

19. For Text content select Size. 

This causes the Size data value to populate the label. 

20. Click <<Apply>> 

21. Click <<Close>> 

Zoom into the drawing and examine the results of the 
changes to the styles. 

 

There are now two styles. One is defined for the 2000 – 5000 scale range, which does 
not display labels, and another style is defined for the 0 – 2000 range, which does display 
labels. At scales above 1:5000 the sewer lines do not display at all. 

22. Zoom into the drawing through the 1:5000, and 1:2000 scales. Notice that the labels appear 
for the sanitary sewer lines when zoomed below 1:2000. 

 
Lesson Review 
In this lesson by creating and applying scale ranges, you created a drawing that is useful 
for viewing the city sewer infrastructure. 
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About Feature Thematic Maps 
Geographic information systems are as much a database application as they are a 
mapping application. Because there is so much data included in GIS, being able to 
present this data in a graphical manner is a powerful way to see data trends, distribution, 
and connections. 

Thematic maps, in the most general terms, creates pictures based on the data. 

A common example of thematic mapping is in the analysis and visualization of land 
values in a city. This type of theme reveals the distribution of land values in a way that a 
standard tabular database query and report could never produce. In the following 
example, parcels in a city are colored based on a range of values that they fall within. A 
legend is included to assist in the interpretation of the theme. 
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Feature thematic maps are really just a collection of styles that are applied to objects 
based on criteria you set in the theme. The following is an example of individual values 
which have been grouped for theme ranges. 

 

 
 
Feature Thematic Map Tools and Functions 
The interface provided in Civil 3D automates much of the creation of ranges and thematic 
representation of those ranges.  
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Methods 
Most thematic maps create ranges which are divided in one of several different ways. 

 
Method Description 

Equal The difference in high and low values is the same for all ranges. You 
can narrow the range of each rule by increasing the number of rules. 

Standard Deviation Ranges are determined, and features are placed in the ranges based 
on their variance from the mean. 

Quantile Each range contains an equal number of entries. 

Jenks (Natural 
Breaks) 

Ranges are based on natural groupings of data values. 

Individual Values Features are placed in a group based on having the same value. This 
is a useful method if there are a small number of different specific 
values, such as the diameters of lines in a sewer collection system. 

 
 
Ramps 
You can assign individual values for the resulting colors that are assigned to ranges in a 
theme. More often, you use ramps which set the styles and colors for you based on a 
From – To color range. Civil 3D provides a default ramping as part of the theme creation, 
but you can change these values. This change is sometimes required based on existing 
colors in the map, or if you want a clearer delineation between ranges. 
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Legend Labels 
Legend labels provide meaningful words and phrases in the resulting legend and in the 
Display Manager. The following example is a theme for pipe diameters. The term “Pipe 
Dia” is added to the legend text to provide context to the legend and Display Manager. 

 

 
 
 
Feature Labels 
In some cases, you want to include text in the map of the actual value the theme is based 
on. In the following example, pipe diameter labels have been added to the theme. 

 

 
 

 

Exercises: Apply Themes to Feature Layers 
In these exercises, you first create a thematic map to display the pipe diameters of the 
sewer lines. The sewer lines are AutoCAD objects but can be accessed through the 
Display Manager and themed similar to connected feature data. You then create a 
thematic map of the parcels based on land values, and insert a legend. 

You will do the following: 

• Create a ramped theme. 
• Create a theme for land values  
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2.2 Thematic Mapping of Linear Objects with Object Data 

  For this exercise you should be in the Planning and Analysis workspace. 

In this exercise, you will display the sewer pipes in different colors according to the size 
field in the object data table. 

1. Open Sewer Theme.dwg from the class dataset folder. 

2. If the Task Pane is not visible, at the 
command line enter MAPWSPACE. 

3. At the command line, enter ON to 
display the Task Pane, which includes 
the Display Manager. 

4. In the Display Manager, click the Data 
button, and select ⇒ Add Drawing 
Data ⇒ Drawing Layer. 

 

 

5. Enable the layer SAN_PIPE_MAIN in the Select Layers 
dialog box. 

6. Click <<OK>>. 
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Notice data layer San_Pipe_Main now 
appears in the Display Manager.  

A layer in the Display Manager is different 
than an AutoCAD layer; it is the name of a 
data source and where you manage its 
properties. 

7. Click on the new feature layer 
and then click on the name 
San_Pipe_Main, and change 
it to Size. 

8. In the Display Manager, right-
click on the new feature layer 
Size and select ⇒ Add Style 
⇒ Theme. 

 

This opens the Thematic Mapping dialog box. Here you will set the criteria that control the display of the 
objects in the Display Manager. In this example, you will apply different colors to sewer pipe lines based 
on values found in the Size field of the Object Data table. 

9. Confirm that A set of specific values is selected from the Theme type: drop-down list. 

10. Click <<Values…>> to open the Thematic Values dialog box. 

11. In the Thematic Values dialog box click the More button <<…>> to the right of the Obtain 
from field. 
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12. Expand Object Data in the Choose 
Data Expression dialog box. 

13. Expand the Sewer_Pipe_Data object 
data table, and then select Size. 

14. Click <<OK>> close the Choose Data 
Expression dialog box, and add the 
expression, :Size@Sewer_Pipe_Data, 
to the Obtain From: field in the Thematic 
Values dialog box. 

 

15. Click <<Read Data>> to display all the 
values found in the Size field of the 
Object Data table.  

16. Right-click on one of the values and 
choose Select All. 

17. Click <<OK>>. 

This takes you back to the Thematic Mapping dialog 
box. 
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18. Enable the column Color to activate the Ramps section. 

19. Select Rainbow from the Ramps drop-down list. 

Color ramps are predefined sets of colors you can use to quickly assign a different color 
to each of a range of values. Once set, you can easily modify any color selection(s) to 
customize your map. 

20. Click <<Done>>. 

The drawing is now displayed showing the pipes colored according to their size. 

 

Bonus Exercise: 
Using the same drawing create a second Thematic Map of the pipes colored by Material. 
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2.3 Thematic Mapping of Polygon Features 

  For this exercise you should be in the Planning and Analysis workspace. 

In this exercise, you apply a theme to the Parcels feature class based on Land Values. 
You then insert a map legend in the drawing. 

1. Open Parcels Theme.dwg from the class dataset folder. 

2. In the Display Manager, select the feature layer 
Parcels and then click the Style button. 

This opens the Style Editor palette.  

 

3. In the Style Editor palette, click <<New Theme>>. 

This opens the Theme Polygons dialog box, where you create a theme, such as applying 
a different color value to each range of land values, resulting in a thematic map. 
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4. Set the Property to LANDVAL. 

5. Set the Distribution to Jenks (Natural 
Breaks). 

6. Set the Number of rules to 5. 

7. For Legend Text, enter Land Value. 

8. Click <<OK>>. 

9. Close the Style Editor. 

The parcels in the drawing are themed. 

 

Lesson Review 
In this lesson you created a theme to better visualize the pipe diameters in the sewer system. You then 
created a thematic map of the parcels based on land values. This drawing can now be printed and 
provided as a map to the Planning department, or used in City council meetings. 
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3 Export AutoCAD Geometry to Different GIS Formats 

Exporting Data Concepts 
Data exported from Civil 3D to other GIS formats includes standard AutoCAD geometry, 
attributes and coordinate systems. As with the import of GIS formats, Civil 3D attempts to 
maintain the integrity of the data as closely as possible within the target format and file.  

 

The nature of GIS data is similar to databases even if the data is in a file format. The 
adherence of standards and classes is more stringent in GIS formats than is typically 
required in an AutoCAD drawing. AutoCAD, and Civil 3D allow objects to be incorrectly 
placed on different layers, attribute data entered without business rules and so on. The 
exception to this is Object Classes that do incorporate standards similar to a typical GIS 
format. 

Because of the expectation of specific standards in other GIS formats, it is important to 
verify the standards and integrity of the outgoing Civil 3D file before performing the actual 
export. 

 
Target File Types 
Target file types have different characteristics and the export is context-sensitive to the 
output type. For example, when exporting to ArcView Shapefile format, only one type of 
geometry and class is accepted by the target. On the other hand, the Autodesk SDF file 
allows multiple classes exported simultaneously and multiple geometry types included in 
each class. 

 

ArcView Shapefile 
The following illustration shows the object type attribute permitted when exporting to an 
ArcView Shapefile. Only one type of geometry type is allowed. 

 

 
 
  

  
Civil 3D objects such as alignments, profiles, parcels, etc., are not 
exported with this command. 
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Autodesk SDF 
The following illustration is an example of an Autodesk SDF file export. In this example, 
multiple classes are created and each can contain point, line, and polygon object types. 
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Exercises: Export to an ArcView SHP file 
In these exercises, you begin in a drawing with parcels and Object Data that contains the 
parcel data. You export the parcel map to ArcView SHP file format. During the export, 
you map Object Data fields to the .dbf file.  

 
You do the following: 

• Export polygons to a SHP file. 
 

3.1 Exporting Polygons to a SHP file 

  For this exercise you should be in the Planning and Analysis workspace. 

In this exercise, you will export closed polygons with attribute data attached from an 
object data table. This is similar to exporting lines or points that have object data or 
external database data attached because the data is attached to the polygon instead of a 
centroid. 

1. Open Taxlot Polygons.dwg from the class dataset folder. 

2. Use the Properties command to view the Object Data attached to the parcels. 

3. Notice the object is an MPolygon. 

4. At the command line enter: Command: MAPEXPORT. 

5. Navigate to the class dataset folder and open the folder called Export. 

6. Select ESRI Shapefile (*.SHP) from the Files of type: list. 

7. Enter Parcels for the File name. 

8. Click <<OK>>. 
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The Export dialog box opens, where you 
select the types of object to export. In this 
exercise you will export the parcels 
represented by the polygon object type, 
and the linked data. 

9. Choose the Polygon option in 
the Object type section. 

10. Click the Select Layers button 

 in the Filter selection 
section, to select layers. 

11. Select the Taxlot_Polygon 
layer to only export the parcel 
lines. 

12. Select the Data tab. 
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13. Click <<Select Attributes>>. 

 

14. In the Select Attributes dialog box, expand 
the Object Data option. 

15. Select the Parcels object data table. 

This will export all the fields in the Parcels object data 
table. This dialog box also allows you to drill down and 
only export selected attributes, but in this case you will 
export all of the fields. 

16. Click <<OK>> to add this information to the 
Data tab of the Export dialog box. 
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17. Select the Options tab. 

Here you have the option to assign a 
coordinate system to the exported data. 

The option to Treat closed polylines as 
polygons is used if the polygons are closed 
polylines instead of MPolygon objects like 
you have in this exercise.   

18. Click <<OK>> to export the 
data. 

 

An Export Progress box opens to indicate progress as 1072 objects with associated data 
are exported. 

19. Open Windows Explorer and navigate to the Export folder in the class dataset. 

Notice that the SHP file and all associated files, including Parcels.dbf, have been created. 

If you have a way to view shapefiles, such as ArcExplorer or ArcGIS, you can open the 
file and verify the export. 

20. Close the drawing without saving any changes. 

 
 
Lesson Review 
In this lesson you exported AutoCAD drawing objects to a Shapefile. These files can now 
be used as a feature source in Civil 3D, and in many other applications. 
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4 Export Civil 3D Objects to Different GIS Formats 

Exporting Civil 3D Objects as GIS Data Concepts 
Types of Civil 3D objects that can be exported: 

• Points 
• Alignments 
• Parcels 
• Pipes 
• Structures 

 

All of the Civil 3D objects from the list above that are in your drawing will be exported, 
even those on frozen layers. There is no way to be selective with this command about 
what is exported. 

The geometry of the Civil 3D objects will be exported along with all of the data created for 
those objects in Civil 3D. 

When exporting Civil 3D objects to GIS data the only file format available is the Autodesk 
SDF file. If you need to provide the data to someone in a different format you can use the 
Bulk Copy command to convert it. The Bulk Copy command is covered in Chapter 9. 

 

 

Exercises: Export Data from Other GIS Formats 
In these exercises you will export Civil 3D objects and their associated data to an SDF 
file. This SDF file could then be used in other applications or converted to another format 
using the Bulk Copy command. 

 

You do the following: 

• Export Civil 3D objects to an SDF file.  
 

 



 
 

 
Page 38 

4.1 Exporting Civil 3D Objects to an SDF File 

  For this exercise you should be in the Civil 3D workspace. 

1. Open Civil 3D Data.dwg from the class dataset folder. 

This drawing contains Civil 3D Points, an Alignment, and Parcels.  

2. Select Ribbon: Output ⇒ 
Export ⇒ Export Civil 
Objects to SDF. 

 

 

3. Confirm the SDF file name is set to Civil 3D Data.sdf and it is located in the class dataset 
folder. 

4. Notice the coordinate system of the drawing is included in the SDF file. 

5. Click <<OK>> to export all of the available Civil 3D Objects in the drawing to the new SDF 
file. 

The command line reports the quantity of each of the exported objects, by category. This 
command exports only the geometry of the Civil 3D objects and does not include labeling 
or stylization.  

In this exercise you exported Civil 3D objects to an SDF file that includes both the 
geometry of those objects and the data that was created in Civil 3D. The SDF could be 
used in another program or even converted to a different file format using the Bulk Copy 
command. 
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4.2 Bulk Copy from an SDF to an SHP 

In this exercise you will use the Bulk Copy command to create a shape file from the 
parcels in the SDF file you just exported. 

  For this exercise you should be in the Planning and Analysis workspace. 

1. Continue working in the drawing Civil 3D Data.dwg from the previous exercise. 

2. In the Display Manager, click the Data button and 
select ⇒ Connect to Data… . 

The Data Connect palette opens.  

 

 

3. Select Add SDF Connection. 

4. Change the Connection name: to Civil 3D Export. 

5. Browse to the class dataset and select the file Civil 3D Data.sdf that you created in the 
previous exercise. 
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6. In the Data Connect palette, click <<Connect>>. 

 

You will see the connection has been added and the list of objects it contains.  There is no need to add 
them to the map as they will only be used as the source of the data in the Bulk Copy command. 

 

7. Select Add SHP Connection. 

8. Change the Connection name: to Parcels. 
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Since you cannot directly create a new SHP file, you assign a folder that receives the 
new SHP when it is created with the bulk copy. 

9. Click the folder button. 

10. Browse to the Export from C3D folder in the class dataset. 

11. Click <<OK>>. 

12. In the Data Connect palette, click <<Connect>>. 

 

A folder icon appears under Add SHP Connection called Parcels.   

13. Close the Data Connect palette. 
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14. In the Map Explorer, select the Streets connection, 
and then click the Tools button and select ⇒ Bulk 
Copy… 

 

 

15. In the Bulk Copy dialog box, for From, select the Civil 3D Export feature source. 

16. For the Target, select Parcels. 

This is the empty folder connection you created for the shape file. 
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17. On the left side of the Bulk Copy dialog, under Select Items to Copy, select the Parcels 
feature class. 

All of the properties are selected, and duplicated in the target feature class (SHP). 

18. Disable the Autogenerated_SDF_ID property.  

19. Click <<Copy Now>>. 

20. In the Continue Bulk Copy dialog box, click 
<<Continue Bulk Copy>>. 

 

21. Civil 3D confirms the number of objects that 
were copied and gives you an option to view 
a log.  

 

22. Click <<OK>>. 

23. Close the Bulk Copy dialog. 

24. In Windows Explorer, navigate to the Export from C3D folder in the class dataset, to confirm 
the SHP and all related files were created. 

Optionally, you can connect back to the new SHP file to verify the integrity of the data exported. 

 

Lesson Review 
In this lesson you exported Civil 3D objects to an SDF file that includes both the 
geometry of those objects and the data that was created in Civil 3D. The SDF could be 
used in another program or even converted to a different file format using the Bulk Copy 
command.  Then you used the Bulk Copy command to create a new SHP file from the 
parcel data that you exported into the SDF. Another powerful aspect of this feature is that 
you can add new data to an existing SHP. 

 
 
 
 
The material in this class is based on the book  
A Practical Guide to GIS in AutoCAD Civil 3D 2018.  
For more information go to www.cadapult-software.com/books 
 


